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Enabling or Disabling Initial Warning Message Box

If you haven't started LAN Manager or if there is a network initialization problem, a warning message 
box appears on your screen when you first start Windows. You can control whether this message box 
appears each time you start Windows.

To enable or disable the initial warning message box:

1 From the Control Panel window, select Networks.

When the Networks - LAN Manager dialog box appears:

2 From the Options menu, choose either "Enable initial warning message" or "Disable initial warning 
message."

You can also disable the warning message by choosing the check box next to the message that 
appears in the warning box: Don't display this warning in the future. To reenable the warning message, 
choose "Enable initial warning message" from the Options menu in the Networks - LAN Manager 
dialog box.



Logging On

Logging on identifies you on the local-area network and establishes you as the user on the 
workstation. When logging on, you type your username and logon password, which are assigned by 
an administrator. Your username is a unique name that identifies you on the network. Your logon 
password identifies you in the domain. Every computer on the network belongs to at least one domain.

To log on to the network:

1 From the Control Panel window, select Networks.

When the Networks - LAN Manager dialog box appears:

2 From the Account menu, choose Logon.

When the Logon dialog box appears: 

3 Type your username and password.

4 Choose Logon.

Depending on how the network is configured, you may need to supply a different password when 
connecting to shared resources. See your administrator.

See Also
Logging Off

Changing Your Password



Logging Off

Logging off removes your username and password from the workstation and breaks any existing 
connections to shared resources.

To log off:

1 From the Control Panel, select Networks.

When the Networks - LAN Manager dialog box appears:

2 From the Account menu, choose Logoff.

If you have connections to network resources, you will receive a message alerting you that logging off 
will break these connections. If you have open files or programs on the network, logging off forces 
these files closed and ends all programs. Be sure to close files and end programs before logging off.

See Also
Logging On



Connecting to a Disk Resource

LAN Manager lets you use shared directories on the local-area network. These directories are called 
disk resources, or shared resources, and are used the same way as disk drives and directories on 
your computer. You can use files and application programs on the disk resource at your workstation as 
though they were stored on your hard drive. When you use a disk resource, you establish a session, 
or connection, to that resource.

You must be logged on to the network before using disk resources.

To connect to a disk resource:

1 From the Main window, select File Manager.

2 From the Disk menu, choose Network Connections.

When the Network Connections dialog box appears:

3 Choose Browse to view available servers.

When the Network Disk Resources dialog box appears:

4 Select a server from the list in Network Servers.

The Resources at (server) list box shows resources available for that server.

5 Select a resource from the Resources at (server) list box. 

6 Choose OK.

When the Network Connections dialog box appears:

7 Type a password (if needed).

8 Choose Connect.

Note: If you can't connect to a disk resource, see your administrator.

If you have access to multiple domains, you can also connect to disk resources in those domains. 

To connect to a disk resource in another domain:

1 From the Network Connections dialog box, choose Browse.

When the Network Disk Resources dialog box appears:

2 Select Domain.

When a list of domains appears:

3 Select a domain. 

Note: You can then connect to a disk resource following steps 4 through 8 in the preceding procedure.

Shortcut:
If you know the disk resource's network path, select File Manager, then Disk Menu. In the Network 
Connections dialog box:

1 Type a drive letter or select one from the Drive list.

2 Type the pathname.

3 Type a password (if needed). 

4 Choose Connect.

See Also
Disconnecting from a Disk Resource

Connecting to a Network Printer



Disconnecting from a Network Printer



Disconnecting from a Disk Resource

To disconnect from a disk resource:

1 From the Main window, select File Manager.

2 From the Disk menu, choose Network Connections.

When the Network Connections dialog box appears:

3 Select the drive letter you want to disconnect.

4 Choose the Disconnect button.

5 Choose the Close button.

If you're using a disk resource in one window and you try to disconnect from that resource in another 
window, you receive a message that the resource is being accessed by another process.

See Also
Connecting to a Disk Resource

Connecting to a Network Printer

Disconnecting from a Network Printer



Connecting to a Network Printer

Printers, like disk resources, can be shared on the network through a server. LAN Manager uses 
printer queues to hold print jobs. Jobs sent to a printer queue are printed one by one, usually in the 
order that the queue receives them.

When connecting your workstation to a network printer, you must assign a devicename to the queue. 
Printer devicenames are LPT1: through LPT3:.

You must be logged on to the network before using network printers.

To connect to a network printer:

1 From the Control Panel, select Printers.

2 From the Printers window, select Networks.

When the Printers - Network Connections dialog box appears:

3 Choose Browse to view other network printers. 

When the Network Printers dialog box appears:

4 Select a server from the list in Network Servers.

The Resources at (server) list box shows the printers available for that server.

5 Select a printer from Printers. 

6 Choose OK.

When the Printers - Network Connections dialog box appears:

7 Type a password (if needed).

8 Choose connect.

Note: If you can't connect to a printer, see your administrator.

If you have access to multiple domains, you can also connect to network printers in those domains. 

To connect to a printer in another domain:

1 From the Printers - Network Connections dialog box, choose Browse.

When the Network Printers dialog box appears:

2 Select Domain.

When a list of domains appears:

3 Select a domain. 

You can then connect to a network printer following steps 4 through 8 in the preceding procedure.

Shortcut:
If you know the printer's network path, select Printers, then Networks. In the Printers - Network 
Connections dialog box:

1 Select a devicename from Port.

2 Type the pathname for the printer.

3 Type a password (if needed). 

4 Choose Connect.

See Also
Viewing Network Printer Queues

Disconnecting from a Network Printer
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Disconnecting from a Disk Resource



Viewing Network Printer Queues

You may want to view a list of available printers to find out where to send a print job, or view a list of 
jobs in a particular queue.

To view network printer queues:

1 From the Main window, select Print Manager. 

The printer queues you're connected to are displayed. Any jobs you have queued to print on those 
printers are also displayed.

To view other network printer queues:

1 From the View menu, choose Other Net Queue.

When the Other Net Queue dialog box appears:

2 Type the pathname of the queue in Network Queue. 

3 Choose View.

A list of printers for that queue is displayed in the list box. Any jobs you have queued to print on that 
printer is also displayed.

See Also
Connecting to a Network Printer

Disconnecting from a Network Printer



Disconnecting from a Network Printer

You don't usually need to disconnect from a printer after sending a print job. However, if you do 
disconnect, it doesn't cancel any of your jobs still waiting in the printer queue.

To disconnect from a network printer:

1 From the Control Panel window, select Printers.

2 Choose Network.

When the Printer - Network Connections dialog box appears:

3 From Network Printer Connections, select the printer you want to disconnect from.

4 Choose Disconnect.

See Also
Connecting to a Network Printer

Connecting to a Disk Resource

Disconnecting from a Disk Resource

Viewing Network Printer Queues



Sending a Message

With LAN Manager, you can send messages to other network users by specifying their username, 
computername, or message alias. You should keep your messages to a few lines of text. 

To send a message:

1 From the Control Panel window, select Networks.

When the Networks - LAN Manager dialog box appears:

2 From the Message menu, choose Send.

3 In To, type a username, computername, or message alias.

4 In Message, type a brief message.

5 Choose Send.

See Also
Receiving a Message



Changing Your Password

To maintain network security, passwords may have expiration dates set up by an administrator. 
Therefore, it may be necessary to change your logon password from time to time. 

To change your password:

1 From the Control Panel, select Networks.

When the Networks - LAN Manager dialog box appears:

2 From the Account menu, choose Change Password.

When the Change Password dialog box appears:

3 In Change Password at, type the name of a server or a domain.

4 In Old Password, type your old password.

5 In New Password, type your new password.

6 Choose OK.

When the Confirm New Password window appears:

7 In Password, type your new password again.

8 Choose OK.

See Also
Logging On

Connecting to a Disk Resource

Connecting to a Network Printer



Receiving a Message

With the Winpopup application, you can see a message on your screen when it arrives. When you 
receive a message at your workstation, Winpopup displays a message box telling you there is a 
message, who the message is from, and the date and time the message was received.

The Winpopup application only displays the current message. If you stop the Winpopup application, 
you can only read messages through the message log stored in the 
LANMAN.DOS\LOGS\MESSAGES.LOG file (where LANMAN.DOS is the root directory for LAN 
Manager).

To read a message:

1 To read a message, choose OK. 

The Winpopup message window appears, containing the message. 

2 After you are finished reading the message, choose Cancel.

The Winpopup message window is closed and the message is stored in the MESSAGES.LOG file.

To dismiss a message without reading it:

1 When the message box appears telling you there is a message, choose Cancel.

The message is saved in the MESSAGES.LOG file.

See Also
Sending a Message



Administrator

A person responsible for maintaining the local-area network. This person typically sets up the network, 
maintains the network's shared resources and security system, creates user accounts, and helps 
users with network problems.



Computername

The name of a server or workstation on a local-area network. Computernames must be unique on the 
network.



Connection

The software link between a workstation and a shared resource. You make connections by assigning 
a local devicename (disk resource, printer, or communication device) on a workstation to a shared 
resource on a server. See also Session.



Devicename

The name by which LAN Manager identifies a disk, printer, or communication device.



Domain

Computers on a local-area network that an administrator groups for administrative and security 
purposes. Every computer on the network belongs to at least one domain.



Logon Password

The password specified when logging on at a workstation or server. The logon password is sent to a 
server when you connect to a shared resource. If an account on the server contains a password that 
matches your logon password, access is granted. If not, LAN Manager asks for a different password.



Message Alias

A name used to receive messages at a workstation. A workstation can have up to 15 aliases, including 
a computername and username. An alias must be unique on the local-area network.



Password

A word a user supplies when he or she logs on at a workstation (the logon password) or connects to a 
shared resource. See also Logon Password.



Printer Queue

A shared resource that routes print jobs to one or more printers connected to a server.



Resource

Any disk drive, directory, file, printer, or communication device that an administrator can share on a 
local-area network. See also Shared Resource.



Server

A computer on a local-area network that controls access to resources such as files and printers. An 
administrator shares the server's resources so that users can use them from their workstations.



Session

A link between a workstation and a server. A session consists of one or more connections to a shared 
resource. It begins when a user connects to a shared resource and continues until the user 
disconnects from the resource. A session can also be ended due to inactivity for a specified period. 
The next time the user uses a resource on the server, a new session begins. See also Connection.



Shared Resource

A resource available on a local-area network. See also Resource.



Username

The name a user types when he or she logs on to the local-area network. It uniquely identifies a user 
on the network.



Workstation

A computer on the local-area network from which a user works with LAN Manager.




